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License Agreement
This manual and the Tokyo fonts are protected by copy-
right law so reproduction or redistribution is strictly pro-
hibited. A single use license is granted the purchaser of the
fonts. The fonts may be installed on more than one ma-
chine, but only one copy of a given font may be in use at
any time.

Please support future enhancements and updates of the
fonts by refusing friend's and colleague’s requests to
“borrow” the fonts. Pirating is illegal and harms both the
font designer and registered users. Thanks.

Guarantee
These fonts have a 30 day money-back guarantee. If you
are not satisfied for any reason, return the fonts and manu-
al and your purchase price will be refunded.

Tokyo fonts ©1995
by Alpine Electronics, Steve Smith
Alpine Electronics
703 lvinson Ave.
Laramie, WY 82070
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Introduction

Welcome to the Tokyo GO fonts! With these fonts
you can use any Windows word processor or page lay-
out program to create and print beautiful GO diagrams.
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This diagram shows the first 121 moves of a game

played in 1938 between Kitani and Shusai. This
game was the basis for the novel The Master of
GO by Yasunari Kawabata who was awarded the
Nobel prizefor literature.

The Tokyo GO fonts were created by postal chess
master Steve Smith, who has been designing com-
mercial chess and game fonts for many years.

What You Need

You will need an IBM PC compatible computer run-
ning the Windows 3.1 (or later) operating system and
any Windows word processor or page layout program.
Earlier versions of Windows do not support TrueType
fonts. To use the PostScript™ version of the fonts you
will need Adobe Type Manager (ATM).

What is Included

The high density floppy disk contains both the True-
Type™ and PostScript™ versions of the fonts T okyo
and TokyoBasic. Also included is a WRITE file To-
kyo.WRI. After al the fonts are installed (see installa-
tion instructions on page 2) use the Windows Acces-
sory program WRITE or aimost any other Windows
word processor to open and printout this test file.
Printouts at 600 dots per inch are included separately
from this User's Guide. Note: the diagrams may not
look as sharp on a 300 dpi or less printer.

All TrueType™ fonts can be used with any program
running under Windows 3.1 or Windows 95. The Post-
Script™ versions requires Adobe Type Manager.

Tokyo — This font can be used to create any type of
GO diagram with or without algebraic borders and with
or without numbered stones. See the keymap and key-
board map on pages 7-8, 10.

TokyoBasic — Numbering the stones is a tricky pro-
cess and this makes the Tokyo font rather complicated.
The TokyoBasic font cannot create numbered GO dia-
grams, but it is very easy to create unnumbered dia-
grams with or without algebraic borders. See the key-
map and keyboard map on pages 9-10.

Other Game Diagram Fonts

Alpine Electronics sells diagram font families for many
other games. The Linares, Hastings and Zirich
chess font families are $49 each, two for $79 or all
three for $99 postpaid including a 14 page User's
Guide. Other game font families include Tendo for
shogi or Japanese chess, Beijing for XiangQi or
Chinese chess, Bermuda for Playing Cards and Bridge,
Las Vegas for Dominoes and Dice, Canton for Mah

pagel



Jong, Edinburgh for checkers, Copenhagen for
Othello, MonteCarlo for backgammon and M agal a-

sy for Fanorona. See sample diagrams for most of

these fonts on pages 5-6. Each of these font families
sells for $49 or any three for $129 postpaid and this in-
cludes a User’s Guide. Be sure to specify Windows or

Macintosh.

Installing the Tokyo Fonts

The following is a summary of the procedure for in-
stalling the Tokyo fonts in your Windows 3.1 or
Windows 95 system. For a more detailed description of
TrueType™ font installation consult your Windows
manual or help menu. For a more detailed description
of PostScript™ font installation consult your Adobe
Type Manager manual.

Important Note: Install only the TrueType or the
PostScript versions of the fonts. Having both the
TrueType and PostScript versions of the same font on
a system will usually cause problems. Most people
will want to use the TrueType fonts unless a) True-
Type will not print all characters properly at the size
you want or b) A commercia printing company has
asked you to use PostScript fonts or c) You have
Adobe Type Manager and you prefer PostScript.

TrueType for Windows 3.1

1) Insert the Tokyo disk into the disk drive 2) Dou-
ble click on the Main icon at the bottom of the Pro-
gram Manager window 3) Double click on the Con-
trol Panel icon 4) Double click on the Fontsicon 5)
Click on the Add button 6) Select the drive (usually
drive &) containing the Tokyo fonts 7) Select the To-
kyo fonts you want to install 8) Click “OK” to install
the selected fonts

TrueType for Windows 95

1) Insert the Tokyo disk into the disk drive. 2) Click
on the Start icon located at the lower left of the
screen. 3) Move the selection arrow to Settings,
then over to the Control Panel icon and click. 4)
Double click on the Fonts Folder icon. 5) Move
the selection arrow to the File menu located at the up-
per left of the window, then down to Install New
Font and click. 6) Select the drive containing the T o-
kyo fonts by clicking on the triangle in the Drive
box and then clicking on the a: drive (the floppy disk
drive may be called the b: drive on some systems). 7)
Select the Tokyo fonts you want to install by click-
ing on them in the List of Fonts box. To select
more than one font hold down the shift key while
clicking or select them al by clicking on the Select
All button. 8) Click on the OK button to install the
selected fonts.

To install PostScript™ fonts in Windows you must
have Adobe Type Manager (ATM) version 2.0 or

higher. Expect to pay about $40 for ATM.

PostScript for Windows 3.1 or Windows 95
1) Double click on the ATM Control Panel icon in
the Program Manager window (If you are running
Windows 95, the ATM icon may be in the Windows
folder or the Control Panel folder.) 2) Click on the Add
button 3) Scroll through the drive/directory list to find
the drive containing the Tokyo fonts 4) Double click
on the drive (usually drive a:) containing the Tokyo
fonts 5) Select the Tokyo fonts you want to install 6)
Click on the Add button 7) Click on the Exit button

8) Click on “Restart Windows” (If you are using ver-
sion 2.5 or higher of ATM you won't need step 8)

Some Examples

We will start by creating a blank 9 x 9 GO board. The
border corner characters are < >, . for the upper left,
upper right, lower left and lower right corners respec-
tively. (Note: on the keyboard a shift “,” is“<" and a
shift “.” is“>"). The border edge charactersare[ _] -
for the left, top, right and bottom edges respectively.
An empty intersection is +, a dotted intersection is =
and ablank spaceisaW. Algebraic bordersinthe T o-
kyoBasic font are the lower case letters a, b, c, ...
and numbers 1, 2, 3, ... O followed by shifted numbers
I, @, #...). To create a9 x 9 Go board open your fa-
vorite Windows word processor, change the font to
TokyoBasic and type the following characters.

Wabcdef ghi W
9< >9
[ +++++++
+=+++=+]
[ +++++++
[ +++=+++
[ +++++++
[ +=+++=+
[ +++++++

RPNWATOON®
PNWAROOON®

Wabcdef ghi W
The diagram should look like the following.

ABCDEFGHI

“ NDWHUIO N OO
- NDNWHUIO N OO

ABCDEFGHI
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A black stone is z and a white stone is Z. To add
stones just use your word processor to change the + or
= characters to z or Z (i.e. use the cursor to highlight
an intersection then type either az or Z to place a black
or white stone on that intersection). After the moves 1.
g6 d6 2. d3 f5 3. f6 d4 the diagram would become.

ABCDEFGHI

00
)
N>

L Osa®)

= NDNWhOoo N 0O

= NDNWhOoo N 0O

ABCDEFGHI

Here is the same diagram with a standard text font.

vabcdef ghi W
o< >9
+++++++]
+=++=+
++Z+77+
+++=Z++
4+ Z++++
+=Z++=+
+Ht+tt

RPNWDSOIO N 00
PNWRAOOIO N

vabcdefghivv

Creating a 19x19 board with TokyoBasic is a similar
process. Algebraic borders up to 27x27 can be created.
The following 19x19 diagram shows the variety of
stones and characters that can be placed on the board.
The font size was reduced to 10 points.
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Below is the same diagram with a standard text font.
Note that for the numbered borders O is 10, shift 1 is
11, shift 2is 12, shift 3 is 13, shift 4 is 14, etc.

Wabcdef ghj kl mopgr st W
< >(
]
] &
=+ =t =] A
] %
+H++zZ {2\ | YH+++
++++X+a+b+14+2++++
B R S
B i i
=+t =+
B i i
B R S
B i i
B R S
B i i
=+t =+
B i i
B R S

PNWDRUIONOOO QLS > *—
PNOBIOION0O©O Gk

\idbcdef ghj kI rmopqrsf W

Now we will use the Tokyo font to create a diagram
with numbered stones. To keep things simple we will
start with a 9x9 board without algebraic borders.
Switch to the Tokyo font and type the following to
create an empty 9x9 board.

< >
]
+=+++=+]
4+
A+ =+++]
4+
+=+++=+]
4]

Below is the empty diagram using the Tokyo font.

We will now place a black stone numbered one on the
g6 intersection. Use the cursor to select the g6 intersec-
tion and type wl. The w is a black stone with aslot for
a single digit number. To put a white stone numbered
2 on the d6 intersection, select the d6 intersection and
type Z “shift” 2. To finish the diagram select d3 and
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type w3, select f5 and type Z “shift” 4, select f6 and
type w5 and select d4 and type Z “shift” 6. At the top
of the next page is the resulting diagram with both a
standard text font followed by the Tokyo font.

[ +++++++]
[ +=+++=+]

[ ++Z@wswi +]
[ +++=ZF++]
[ ++Z7++++4]
[ +=WB++=+]

[ +++++++]

000

Now we will add some two digit numbered stones.
Start with an empty Tokyo diagram, select the b2 in-
tersection and type xbq (for a black stone numbered
28), select g5 and type ZBR (for a white stone
numbered 29), select ¢7 and type xgm (for a black
stone numbered 74), select h8 and type ZGN (for a
white stone numbered 75). Note: x is the black stone
with aslot for atwo digit number, the black tens digits
lto9areatoi, thewhitetensdigitslto9are A tol,
the black units digits1to 9 arej tor (0 is s) and the
white units digits 1L to 9 are Jto R (0 is S). See key-
maps on pages 7-8, 10. Below is the resulting diagram
with both a standard text font followed by the Tokyo
font.

[ ++++++ZCN]
[ +xgmt++=+]
+++++++]

[ +++=+ZBR+]
[ +++++++]
[ +=+++=+]
[ xbg++++++]

)
&/

-©

Three digit numbers require a new trick. The hundreds

and tens digits use standard keyboard characters, but the
units digits require upper ASCII characters. To access
these upper ASCII characters you must do the follow-
ing: make sure the Numlock key is on, hold down the
Alt key, use the numeric keypad to type a O followed
by the corresponding three digit ASCII number and
then release the Alt key. See the keymap on pages 7-8
for the ASCII numbers for each of the units digits. It
is also possible to access the upper ASCII characters
with the Character Map Accessory program-see tip
5 on page 5. Start with an empty 9x9 Tokyo diagram.
Select the d7 intersection and type yt3 then turn on the
Numlock key, hold down the Alt key, use the numeric
keypad to type a 0 followed by the 187 then release the
Alt key, (for ablack stone numbered 137), select the h4
intersection and type ZT “shift” 3 then hold down the
Alt key, use the numeric keypad to type a O followed
by the 198 then release the Alt key (for a white stone
numbered 138), select the b5 intersection and type yu5
then hold down the Alt key, use the numeric keypad to
type a O followed by the 183 then release the Alt key,
(for ablack stone numbered 253), select the e4 intersec-
tion and type ZU “shift” 5 then hold down the Alt key,
use the numeric keypad to type a O followed by the 194
then release the Alt key, (for a white stone numbered
254). The resulting diagram is shown below.

©

)
&/

(13—
(138

P

The algebraic borders in the Tokyo font also require
upper ASCII characters. To access these upper ASCI|

characters you must do the following: make sure the
Numlock key is on, hold down the Alt key, use the nu-

meric keypad to type a O followed by the corresponding
three digit ASCII number and then release the Alt key.
See the keymaps on pages 7-8 for the ASCIlI numbers
for the algebraic border characters. It is also possible to
access the upper ASCII characters with the Char acter

Map Accessory program—see tip 5 on page 5.

Tips for Using the Fonts

1)

It is best to make the diagram as large as possible when
you are creating it or editing it. Once the diagram is
finished you can reduce it to the needed size by select-
ing the entire diagram and reducing the font’s point
size. A creation size of 24 points and a finished size of
10 or 12 points would be a good place to start.
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2) Use your word processor’s copy and paste features to
move either empty GO diagrams or evolving GO dia-
gramsto the appropriate places in your document.

3) To remove a stone just select it with your cursor and
deleteit, just as you would delete aword or character in
atext document. If you have trouble deleting numbered
stones, you may need to click the cursor on the mid-
point of the intersection or stone that is to the right of
the stone you are removing and drag to the left until
the stone is highlighted before you delete it.

4) To remove or change the numbers of a numbered stone
click the cursor alittle to the right of the stone whose
numbers you want to change then delete the numbers
by hitting the backspace or delete key.

5) To usethe Character Map Accessory program first
switch from the program you are in to the Program
Manager. Double click on the Accessories icon then
double click on the Character Map icon. Change the
font to Tokyo and double click on each of the charac-
ters you want to add to your document. Click on the
Copy box. Switch back to your document. Select the
Tokyo font in your document. Position the cursor
where you want to place the characters. Finally choose
Paste from the Edit menu.

6) To insert upper ASCII characters from the keyboard
first select the Tokyo font. Make sure the Numlock
key is on, hold down the ALT key, type O followed by
the three digit ASCIlI number for the character. The
ASCII numbers are on pages 7-8.

7) If the go diagrams are not square or there are gaps in
the vertical lines, set the line spacing equal to the same
point size as the font’s point size.

If you have any problems or suggestions for improv-
ing the fonts, please send a note to Alpine Electron-
ics. Include a description of the problem, a printout
illustrating the problem, a description of the comput-
er, printer and software you are using and the seria
number on your Linares disk. Help is also available
viaemail. Theinternet email addressis:
alpine@partae.com

Other Game Diagram Fonts

Alpine Electronics also sells other game diagram

fonts. The fonts are $49 each or any three for $129
postpaid with User’s Guide. (see pages 1-2). If you

order two chess fonts the price is $79 and all three

cost $99 postpaid.

Linares, Hastings and Zurich (chess)

1. e4 e5 2. f4 ef4 3. )Nf3 d5 4. ed5 A.d6 5. HNc3
Ne7 6.d4 0-0 7. Ad3 Nd7 8. 0-0 h6? [8. ... Hgh

9. Hed Hf6 10. HA6 &d6 11. c4 Lgd=; 8. ... D6 9. He5
Heds 10. Hd5 Hds 11 A4 Hf4 12, Bf4 Bg5=] 9. Ne4
ANds5 10. c4 He3 11. He3 fe3 12. ¢c5

E/Q.

,,,,,,,,,,,,,

2 7
% / YY)
/

,,,,,,,,,,,,,,,,,,,

o fe7 12, ... 9f42 13. g3 295 14. &fg5 hg5 15.
15. WhS=; 13. ... f5 14. ©c3 g5 15. h4 fe7 16.
&ads=113. Lc2! Be8 [13. ... &f6 14 Wd3 Qe4 15. We4

g6 16. We3 g7+ - »] 14. Wd3 e2

15. Ad6!? [15. Ef21=] /8?2 [15. ... efl=¥ 16. Efl &6
17. &f7 @f7 18. ©e5 ©g8 Wwh7! #h7 20. £b3+-; ~15.
... £d6 16. ¥h7 ®f8 17. cd6 efl=% 18. Efl cd6 19.
Wh8 @e7 20. Eel 9e5 21. Wg7 Eg8 22. Wh6 Wb6 23.
@h1 fe6 24. deS=] 16. Af7! ef1 =¥ 17. Ef1

7

(] %
//%/%/
2&”@3//
8

ya1an

17. ..215 [17. ... &f7 18. DHe5 g8 19. Wh7 Hh7 20.
£b3+-;17. ... Wd5 18. £b3 Wf7 19. &7 &f7 20. W4
Hgb 21. W8 &f6 22. Hh4 £h4 23. Wf7 Sh7 24,
We8+—; 22. ... ©g5 23. Wd5 &h4 24. Bf4 &g4 25. g3
&h3 26. @gZ#] 18. ¥f5 ¥Wd7 19. Wf4 [19. Wd3!+-1]
816 20. N3e5 We7 21. 2b3 Le5 22. He5 h7
23. We4! [A EfS+-]11-0

page5



Fonts on this page are $49 with User's Guide or $129
for three. Send postcard to request compl ete printouts.

Tendo (shogi or Japanese chess)

9 8 7 6 5 4 3 2 1
7 [EEEEECEEE- | e
¥ | B |- |‘wdpee
g |HF A= | V"
# w7 | El&/B
e - 25 | [EAR
= e SRR
U BE EEEEEE % kb

. Telh ¥ | xlels)
B i8R 6 | T o H[FE]» &

Beijing (XiangQi or Chinese chess)
123456789

QOO S00

| I I There are other

)‘@ @— border and piece

€'9——€'|9——€'P——€'|9——€9 styles.
ST T 77 EHDE®

ETFTETET® | KON

Ai 2 | oee®

BEEEDDEBE

987654321
Edinburgh (checkers)

Checkers and numbers can
be placed on dark sguares.
Six different borders in-
cluding algebraic for up to
a10x10 board. Five dif-
ferent checker styles.

Oevee®
Ococe
®ovaec
Qo0eo

19
18

Stone numbering is optional
and there are algebraic
borders for up to a 27x27
board. There are several

HJ
B
00,
0 other pieces symbols.
00
5210
?
\

BCD

N
17 OO®
16 @$
15 (90

O®@B86 0
@O @9 X

14
13 (108)

2 |-

Copenhagen (Othello)

0®E® 006
®©0068=6®
0000000

®®00®E®
®0c0e008

06060 ©®68®

0P 080®

®@08®®e®

Thereisan dge-

braic border for
up to a 10x10
board. Number-
ing the disks is
optional.

MonteCarlo (backgammon)

13 14 15 16 17

18

12 11 10 9 8 7

Bermuda (playing cards)

19 20 21 22 23 24

Vi
bom | |

Las Vegas (dice and domlnoes)
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oo
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0o ee

Canton (Mah Jong)
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Tokyo Keymap

Keystroke Char

+

Al

A

OCTO—— *R >RABHR ~0COONOIRWNRLSEX<——.9g~< XS~~~ NN -

X@CeO®0000®0® - |- -7 {7 ++

E N B G B @ N 2

= @

B N B2 5 0o o N o o & w o =

Symbol Explanation
intersection
intersection with dot
upper left border corner
top border
upper right border corner
left border
right border
lower left border corner
bottom border
lower right border corner
black stone
white stone
black stone with highlight
white stone with highlight
black stone with single digit number
black stone with two digit number
black stone with three digit number
black stone with square
white stone with square
black stone with triangle
white stone with triangle
yin-yang stone
X symbol
blank space
single digit "1" for black stone
single digit "2" for black stone
single digit "3" for black stone
single digit "4" for black stone
single digit "5" for black stone
single digit "6" for black stone
single digit " 7" for black stone
single digit "8" for black stone
single digit "9" for black stone
single digit "0" for black stone
single digit "1" for white stone
single digit "2" for white stone
single digit "3" for white stone
single digit "4" for white stone
single digit "5" for white stone
single digit "6" for white stone
single digit "7" for white stone
single digit "8" for white stone
single digit "9" for white stone
single digit "0" for white stone
tensdigit "1" for two digit number for black stone
tensdigit "2" for two digit number for black stone
tensdigit "3" for two digit number for black stone

Keystroke Char

< C+ N - O0OT OS3 —X——ITQ Qo

<KCHOWITOUOZZIrXae—IOTMMOUOm>

a

@ = N @B @

[CONN I OB O S B O O

= @

© ® w > o A e o o BoE B ®m N o
6 © ® w o o s e e -

L N

Symbol Explanation
tensdigit "4" for two digit number for black stone
tensdigit "5" for two digit number for black stone
tensdigit "6" for two digit number for black stone
tensdigit " 7" for two digit number for black stone
tensdigit "8" for two digit number for black stone
tensdigit "9" for two digit number for black stone
unitsdigit 1" for two digit number for black stone
unitsdigit "2" for two digit number for black stone
unitsdigit "3" for two digit number for black stone
unitsdigit "4" for two digit number for black stone
unitsdigit "5" for two digit number for black stone
tensdigit "6" for two digit number for black stone
unitsdigit " 7" for two digit number for black stone
unitsdigit 8" for two digit number for black stone
units digit 9" for two digit number for black stone
units digit "0" for two digit number for black stone
hundreds digit "1" for three digit number for black stone
hundreds digit "2" for three digit number for black stone
hundreds digit "3" for three digit number for black stone
hundreds digit "4" for three digit number for black stone
hundreds digit "5" for three digit number for black stone
hundreds digit "6" for three digit number for black stone
tensdigit "1" for two digit number for white tone
tensdigit "2" for two digit number for white tone
tensdigit "3" for two digit number for white gone
tensdigit "4" for two digit number for white tone
tensdigit "5" for two digit number for white tone
tensdigit "6" for two digit number for white tone
tensdigit " 7" for two digit number for white gone
tensdigit "8" for two digit number for white gone
tensdigit 9" for two digit number for white gone
unitsdigit 1" for two digit number for white Stone
unitsdigit "2" for two digit number for white Stone
unitsdigit 3" for two digit number for white stone
unitsdigit “4" for two digit number for white stone
unitsdigit 5" for two digit number for white Stone
tensdigit "6" for two digit number for white tone
unitsdigit " 7" for two digit number for white Stone
unitsdigit 8" for two digit number for white stone
units digit 9" for two digit number for white stone
units digit "0" for two digit number for white stone
hundreds digit "1" for three digit number for white Sone
hundreds digit "2" for three digit number for white Sone
hundreds digit "3" for three digit number for white Sone
hundreds digit "4" for three digit number for white Sone
hundreds digit "5" for three digit number for white Sone
hundreds digit "6" for three digit number for white gone

Note: Keymap continues on the next page.
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Tokyo Keymap (continued)

ASCII  Char Symbol Explanation ASCIl  Char Symbol Explanation
130 (or 180) 0 units digit"0" for three digit number for black stone 216 16 agebraic border "16"
131 (or 181) i units digit"1" for three digit number for black stone 217 17 agebraic border "17"
132 (or 182) B units digit "2" for three digit number for black stone 218 18 agebraic border "18"
133 (or 183) g units digit"3" for three digit number for black stone 219 19 agebraic border "19"
134 (or 184) 4 units digit "4" for three digit number for black stone 220 20 agebraic border "20"
135 (or 185) g units digit 5" for three digit number for black stone 221 21 agebraic border "21"
136 (or 186) 8 units digit"6" for three digit number for black stone 222 22 agebraic border "22"
137 (or 187) i units digit"7" for three digit number for black stone 223 23 agebraic border "23"
138 (or 188) g units digit "8" for three digit number for black stone 224 24 agebraic border "24"
139 (or 189) g units digit 9" for three digit number for black stone 225 25 agebraic border "25"
170 (or 190) 0 units digit"0" for three digit number for white Sone 226 26 agebraic border "26"
171 (or 191) 1 units digit"1" for three digit number for white Sone 227 27 agebraic border "27"
172 (or 192) 2 units digit"2" for three digit number for white Sone 228 A algebraic border "A"
173 (or 193) 8 units digit"3" for three digit number for white Sone 229 B algebraic border "B"
174 (or 194) 4 units digit "4" for three digit number for white Sone 230 C algebraic border "C"
175 (or 195) 5 units digit"5" for three digit number for white Sone 231 D algebraic border "D"
176 (or 196) 6 units digit"6" for three digit number for white Sone 232 E algebraic border "E"
177 (or 197) 7 units digit"7" for three digit number for white Sone 233 F algebraic border "F"
178 (or 198) 8 units digit"8" for three digit number for white Sone 234 G algebraic border "G"
179 (or 199) 9 units digit"9" for three digit number for white Sone 235 H algebraic border "H"

137 a hundreds digit "7 for three digit number for black stone 236 I algebraic border "I"
138 g hundreds digit "8" for three digit number for black stone 237 J algebraic border "J'
139 g hundreds digit "9" for three digit number for black stone 238 K algebraic border "K"
167 7 hundreds digit "7* for three digit number for white stone 239 L algebraic border "L"
168 8 hundreds digit "8" for three digit number for white stone 240 M algebraic border "M"
169 s hundreds digit "9" for three digit number for white stone 241 N algebraic border "N"
201 1 algebraic border "1" 242 O algebraic border "O"
202 2 algebraic border "2" 243 P algebraic border "P"
203 3 algebraic border "3" 244 Q algebraic border "Q"
204 4 algebraic border "4" 245 R algebraic border "R"
205 5 algebraic border "5" 246 S algebraic border "S"
206 6 algebraic border "6" 247 T algebraic border "T"
207 7 algebraic border " 7" 248 U algebraic border "U"
208 8 algebraic border "8" 249 \Y algebraic border "V*"
209 9 algebraic border "9" 250 w algebraic border "W"
210 10 algebraic border "10" 251 X algebraic border " X"
211 11 algebraic border "11" 252 Y algebraic border "Y™"
212 12 algebraic border "12" 253 z algebraic border "Z"
213 13 algebraic border "13" 254 AA algebraic border "AA"
214 14 algebraic border "14" 255 5 copyright notice
215 15 algebraic border "15"

To insert upper ASCII characters from the keyboard first select the Tokyo font. Make sure the Numlock key ison,
hold down the ALT key, type O followed by the three digit ASCII number for the character and then release the Alt
key.

To insert upper ASCII characters using the Character Map Accessory program first switch from the program you
arein to the Program Manager. Double click on the Accessories icon then double click on the Character Map
icon. Change the font to Tokyo and double click on each of the characters you want to add to your document.
Click on the Copy box. Switch back to your document. Select the Tokyo font in your document. Position the
cursor where you want to place the characters. Finally choose Paste from the Edit menu.
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TokyoBasic Keymap

Keystroke Char

+

N

f e ey

P SRLAHER -~ OOV WNRSEX<— — .9~~~ NN -

Xx@COO®OOO® L | - 4 ++

0N O~ WON =

—_ o = =
Noohrwhwaoo

Symbol Explanation
intersection
intersection with dot
upper left border corner
top border
upper right border corner
left border
right border
lower left border corner
bottom border
lower right border corner
black stone
white stone
black stone with highlight

white stone with highlight

black stone with square

white stone with square
black stone with triangle
white stone with triangle

yin-yang stone
X symbol

blank space
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
agebraic border "
agebraic border "
agebraic border "
agebraic border "
agebraic border "
agebraic border "
agebraic border "
agebraic border "

PEEQa~NauaruNR

PR R E e
NahanN

Keystroke Char
18
19
20
21
22
23

N
=

P XSE<C AP -O0TOSI—x"——TQ 0000w TVOZZIrrXa—— *

IZEN<XKXS<CHOWIODUVOZErXc —IOTMOOW>NNERN

v

Symbol Explanation

agebraic border
agebraic border
agebraic border
agebraic border

g
g
Q"
no
agebraic border "
agebraic border "
agebraic border "
agebraic border "
agebraic border "
agebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "

algebraic border '
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border '
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "
algebraic border "

22"
23"
24"
25"
26"
27"

N<X2<CHduZQUIQZEINAG=TQUMgQuI>R

algebraic border "AA"
copyright notice
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Tokyo Keyboard Map

s|n |8 e |8 |6 |8 |8 |8 |8 @8 |-+ |+
s (@& | & | Qy@u@i@°p|—[—|]@\
i o e |8 |a |8 |o|&8|8|l8 |8
hit .Zox@ a | 8 | B L'—ll@/
option
N L R Y ] AT T T
T T Jal- -] [oleq
I U B f 98h11 2k3|4;5
it OX|s szl -7 |0
option
TokyoBasic Keyboard Map
1|2|3|4/5|6|7|8/|9]|10|L|+
Q| W, E ylul 1o rP| k4 &
Al S| D, f Gg H| J| K| L | (
anift ® x c/v B/ N M| LJd @
option
|12 18 |14 |15 |16 |17 |18 |19 |20 | T |1
1. 19 126 |27 | O | @, B
AR 2t 22 |28 |
shift O X z| |25|24 |7 |O,
option
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